
KU970 User Guide
- English

Disposal of your old appliance
1. When this crossed-out wheeled bin symbol is attached to a product it means 

the product is covered by the European Directive 2002/96/CE.
2. All electrical and electronic products should be disposed of separately from the

municipal waste stream via designated collection facilities appointed by the
government or the local authorities.

3. The correct disposal of your old appliance will help prevent potential negative
consequences for the environment and human health.

4. For more detailed information about disposal of your old appliance, please
contact your city office, waste disposal service or the shop where you purchased
the product.

This document is the user guide for the 
LG KU970 3G Video Mobile Phone. 
All rights for this document are reserved by 
LG Electronics. Copying, modifying and
distributing this document without the
consent of LG Electronics are prohibited.
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Introduction

Congratulations on your purchase of the
advanced and compact KU970 3G video
mobile phone, designed to operate with the
latest digital mobile communication
technology.

Introduction

This user’s guide contains important
information on the use and operation of
this phone. Please read all the
information carefully for optimal
performance and to prevent any damage
to or misuse of the phone. Any changes
or modifications not expressly approved
in this user’s guide could void your
warranty for this equipment.

Use of phone cases with magnetic locks
with slide type phones has caused
problems such as loss of network signal
and phones powering off. 
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For Your Safety

Please read these simple guidelines. Not
following these guidelines may be dangerous
or illegal. Further detailed information is
given in this manual.

WARNING! 
• Mobile Phones must be switched off at all

times in aircrafts.
• Do not hold the phone in your hand while

driving.
• Do not use your phone near petrol stations,

fuel depots, chemical plants or blasting
operations.

• For your safety, use ONLY specified
ORIGINAL batteries and chargers.

• Do not handle the phone with wet hands
while it is being charged. It may cause an
electric shock or seriously damage your
phone.

• Keep the phone in a safe place out of small
children’s reach. It includes small parts which,
if detached, may cause a choking hazard.

CAUTION!
• Switch off the phone in any area where

required by special regulations. For example,
do not use your phone in hospitals or it may
affect sensitive medical equipment.

• Emergency calls may not be available under
all mobile networks. Therefore, you should
never depend solely on your mobile phone for
emergency calls.

• Only use ORIGINAL accessories to avoid
damage to your phone.

• All radio transmitters carry risks of
interference with electronics in close proximity.
Minor interference may affect TVs, radios,
PCs, etc.

• Batteries should be disposed of in accordance
with relevant legislation.

• Do not dismantle the phone or battery.

For Your Safety
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Please read these simple guidelines. Not
following these guidelines may be dangerous
or illegal. Further detailed information is
given in this manual.

Certification information
(SAR)
THIS DEVICE MEETS INTERNATIONAL
GUIDELINES FOR EXPOSURE TO RADIO
WAVES

Your mobile device is a radio transmitter and
receiver. It is designed and manufactured not
to exceed the limits for exposure to radio
frequency (RF) recommended by international
guidelines (ICNIRP). These limits are part of
comprehensive guidelines and establish
permitted levels of RF energy for the general
population. The guidelines were developed by
independent scientific organisations through
periodic and thorough evaluation of scientific
studies. The guidelines include a substantial
safety margin designed to assure the safety of
all persons, regardless of age and health.

The exposure standard for mobile devices
employs a unit of measurement known as the
Specific Absorption Rate, or SAR. The SAR
limit stated in the international guidelines is
2.0 W/kg*. Tests for SAR are conducted using
standard operating positions with the device
transmitting at its highest certified power level
in all tested frequency bands. Although the
SAR is determined at the highest certified
power level, the actual SAR of the device while
operating can be well below the maximum
value. This is because the device is designed to
operate at multiple power levels so as to use
only the power required to reach the network.
In general, the closer you are to a base station,
the lower the power output of the device.
Before a phone model is available for sale to
the public, compliance with the European
R&TTE directive must be shown. This directive
includes as one essential requirement the
protection of the health and the safety for the
user and any other person. The highest SAR
value for this device when tested for use at the
ear is 0.756 W/kg.
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Guidelines for Safe and Efficient Use
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This device meets RF exposure guidelines when
used either in the normal use position against
the ear or when positioned at least 1.5 cm
away from the body. When a carry case, belt
clip or holder is used for body-worn operation,
it should not contain metal and should
position the product at least 1.5 cm away from
your body. In order to transmit data files or
messages, this device requires a quality
connection to the network. In some cases,
transmission of data files or messages may be
delayed until such a connection is available.
Ensure the above separation distance
instructions are followed until the transmission
is completed. The highest SAR value for this
device when tested for use at the body is
0.327 W/kg.

* The SAR limit for mobile devices used by the
public is 2.0 watts/kilogram (W/kg) averaged
over ten grams of body tissue. The guidelines
incorporate a substantial margin of safety to
give additional protection for the public and to
account for any variations in measurements.
SAR values may vary depending on national
reporting requirements and the network band.

For SAR information in other regions please
look under product information at
www.lgmobile.com.

Product care and
maintenance

] Do not disassemble this unit. Take it to a
qualified service technician when repair
work is required.

] Keep away from electrical appliances such
as a TV's, radios or personal computers.

] The unit should be kept away from heat
sources such as radiators or cookers.

] Never place your phone in a microwave
oven as it will cause the battery to explode.

] Do not drop.

] Do not subject this unit to mechanical
vibration or shock.

WARNING! 
Only use batteries, chargers and accessories
approved for use with this particular phone
model. The use of any other types may
invalidate any approval or warranty applying
to the phone, and may be dangerous.

KU970_Eng(AUS)_0312  07.03.12  11:3 AM  Page 8



9

G
uidelines for Safe and Efficient U

se

] The coating of the phone may be damaged
if covered with wrap or vinyl wrapper.

] Do not use harsh chemicals (such as
alcohol, benzene, thinners, etc.) or
detergents to clean your phone. There is a
risk of this causing a fire.

] Do not subject this unit to excessive smoke
or dust.

] Do not keep the phone next to credit cards
or transport tickets; it can affect the
information on the magnetic strips.

] Do not tap the screen with a sharp object
as it may damage the phone.

] Do not expose the phone to liquid or
moisture.

] Use accessories, such as earphones and
headsets, with caution. Ensure that cables
are tucked away safely and do not touch
the antenna unnecessarily.

] Please remove the data cable before
powering on the handset.

Efficient phone operation
To enjoy optimum performance with
minimum power consumption please.
] Do not hold the antenna when the phone is

in use. If you hold it, it can affect call quality,
it may also cause the phone to operate at a
higher power level than needed and shorten
talk and standby times.

Electronic devices
All mobile phones may get interference,
which could affect performance.
] Do not use your mobile phone near

medical equipment without requesting
permission. Avoid placing the phone over
pacemakers (i.e. in your breast pocket.)

] Some hearing aids might be disturbed by
mobile phones.

] Minor interference may affect TVs, radios,
PCs, etc.
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Road safety
Check the laws and regulations on the
use of mobile phones in the areas when
you drive.

] Do not use a hand-held phone while
driving.

] Give full attention to driving.

] Use a hands-free kit, if available.

] Pull off the road and park before making or
answering a call if driving conditions so
require.

] RF energy may affect some electronic
systems in your motor vehicle such as a car
stereo or safety equipment.

] If your vehicle is equipped with an air bag,
do not obstruct it with installed or
portable wireless equipment. It can cause
serious injury due to improper
performance.

If you are listening to music whilst outside
and about, please ensure that the volume
is at a reasonable level so that you are

aware of your surroundings. This is
particularly imperative when attempting
to cross the street.

Avoid damage to your
hearing
Damage to your hearing can occur if you are
exposed to loud sound for long periods of
time. We therefore recommend that you do
not turn on or off the handset close to your
ear. We also recommend that music and call
volumes are set to a reasonable level.

Blasting area
Do not use the phone where blasting is in
progress. Observe restrictions, and follow any
regulations or rules.

Potentially explosive
atmospheres
] Do not use the phone at a refueling point.

Don't use near fuel or chemicals.

] Do not transport or store flammable gas,
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liquid, or explosives in the compartment of
your vehicle, which contains your mobile
phone and accessories.

In aircraft
Wireless devices can cause interference in
aircraft.
] Turn off your mobile phone before

boarding any aircraft.

] Do not use it on the ground without crew
permission.

Children
Keep the phone in a safe place out of small
children's reach. It includes small parts which
if detached may cause a choking hazard.

Emergency calls
Emergency calls may not be available under
all mobile networks. Therefore, you should
never depend solely on your mobile phone
for emergency calls. Check with your local
service provider.

Battery information and
care
] You do not need to completely discharge

the battery before recharging. Unlike other
battery systems, there is no memory effect
that could compromise the battery's
performance.

] Use only LG batteries and chargers. LG
chargers are designed to maximize the
battery life.

] Do not disassemble or short-circuit the
battery pack.

] Keep the metal contacts of the battery
pack clean.

] Replace the battery when it no longer
provides acceptable performance. The
battery pack may be recharged hundreds of
times until it needs replacing.

] Recharge the battery if it has not been
used for a long time to maximize usability.

] Do not expose the battery charger to
direct sunlight or use it in high humidity,
such as the bathroom.
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] Do not leave the battery in hot or cold
places, this may deteriorate the battery
performance.

] Risk of explosion if battery is replaced by
an incorrect type.

] Dispose of used batteries according to the
manufacturer’s instructions. 

Driver Safety Tips
Your wireless telephone gives you the
powerful ability to communicate by 
voice - almost anywhere, anytime. But an
important responsibility accompanies the
benefits of wireless phones, one that
every user must uphold. 
When driving a car, driving is your first
responsibility. When using your wireless
phone behind the wheel of a car, practice
good common sense and remember the
following tips:

] Use a hands free device. If possible, add an
additional layer of convenience and safety
to your wireless phone with one of the
many hands free accessories available today.

] Let the person you are speaking with know
you are driving; if necessary, suspend the
call in heavy traffic or hazardous weather
conditions. Rain, sleet, snow, ice and even
heavy traffic can be hazardous.

] Do not take notes or look up phone
numbers while driving. Jotting down a “to
do” list or flipping through your address
book takes attention away from your
primary responsibility, driving safely.

] If possible, place calls when you are not
moving or before pulling into traffic. Try to
plan calls when you will not be driving.

] Do not engage in stressful or emotional
conversations that may be distracting. Make
people you are talking with aware you are
driving and suspend conversations that have
the potential to divert your attention from
the road.
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] Use your wireless phone to call emergency
services for yourself or others. Dial 0-0-0
local emergency number in the case of fire,
traffic accident or medical emergencies.
Remember, it is a free call on your wireless
phone! Dial 1-1-2 internationally for
emergency services.

] Use your wireless phone to help others in
emergencies, if you see an auto accident
crime in progress or other serious
emergency where lives are in danger, call 0-
0-0 to call emergency number, as you would
want others to do for you.

] Call roadside assistance or a special non-
emergency wireless assistance number when
necessary. If you see a broken down vehicle
posing no serious hazard, a broken traffic
signal, a minor traffic accident where no one
appears injured, or a vehicle you know to be
stolen, call roadside assistance or other
special nonemergency wireless number.

13
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KU970 Features

KU
970 Features

Parts of the phone

Open view

Earpiece

Scrolling bar
] In standby mode:

Briefly : List of Profiles
Briefly : Contacts list
Briefly press: Opens the

menu screen
: Messaging
: Calendar

] In menu: scroll up & down
Briefly press: OK key

LCD screen
] Top: Icons showing signal

strength, battery level and
various other functions

] Bottom: Soft key
indications

Internal camera lens

Microphone

Alpha numeric keys 
] In standby mode: Input

numbers to dial. Hold down:
for international calls.
to dial voice mail centre.
to for speed dials.

] In editing mode: Enter
numbers & characters.With the up/down scrolling the

bar, you can select menu and
functions more easily.
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KU
970 FeaturesLeft soft key/ Right soft key

Performs the function indicated at the bottom of
the display.

Clear key
] Clears a character with each press. Hold 

the key down to clear all input. 
] Use this key to go back to a previous screen.

End key
] Switch on/off (hold down)
] End or reject a call.

Send key 
] Dials a phone number and answers a call.
] In standby mode: Shows a history of calls

made, received, and missed.
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KU970 Features

KU
970 Features

Left side view Right side view 

Side keys 
] In standby mode (open):

Key tone volume adjustment
] In standby mode (closed):

Turns the LCD light on.
] In menu: Scrolls up & down.
] During a call: Earpiece volume

adjustment

Headset/Charger/Cable
connector

Note
] To protect your hearing

while the slide is open,
maximum volume level is 3.

Note
] Please ensure phone is

powered on and in idle
mode before connecting
the USB cable.

Menu key
] Opens the main menu.
] Opens the task manager (Long press).

Camera hot key

Holes for a carrying strap
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Rear view

U
S
IM

Battery

External 
camera lens

Flash

Battery cover release
latch
Press this button to
remove the battery cover.

USIM card socket

Mirror

Battery
terminals

KU
970 Features

Menu key
] Opens the main menu.
] Opens the task manager (Long press).

Camera hot key

Battery cover
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Installing the USIM card
and battery
1. Installing the USIM card.

Your USIM card contains your phone number,
service details and contacts and must be
inserted into your handset.
If your USIM card is removed then your
handset becomes unusable until a valid one
is inserted. Always disconnect the charger
and other accessories from your handset
before inserting and removing your USIM
card. Slide the USIM card into the USIM card
holder. Make sure that the USIM card is
properly inserted and the gold contact area
on the card is facing downwards. To remove
the USIM card, press down lightly and pull it
in the reverse direction.

To insert the USIM card      To remove the USIM card

2. Installing the battery.

Insert the the battery into the battery
compartment as metal contacts meet in the
middle of the phone.

Push down the top of the battery until it
snaps into place. Place the battery cover to
the phone as shown.

Getting Started

18
G

etting Started

Note
] The metal contact of the USIM card can

easily be damaged by scratches. Pay
special attention to the USIM card while
handling. Follow the instructions supplied
with the USIM card.

U
S
IM

U
S
IM

U
S
IM

U
S
IM
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To remove the battery.

Turn the power off. (If the power is left on,
there is a chance you could lose the stored
telephone numbers and messages.)

Press and hold down the battery release
button and lift off the battery cover. Turn the
phone up-side down, as shown, then lift up
the battery with your fingers and pull-out the
battery. 

Charging the Battery
Before connecting the travel adapter to the
phone you must first install the battery.

1. With the arrow facing you as shown in the
diagram push the plug on the battery
adapter into the socket on the left side of
the phone until it clicks into place.

2. Connect the other end of the travel
adapter to the mains socket. 

19

Note
] Only use the charger included in the box.
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3. The moving bars on the battery icon will
stop after charging is complete.

4. Ensure the battery is fully charged before
using the phone for the first time.

Disconnecting the
charger
Disconnect the travel adapter from the
phone as shown in the diagram below.

WARNING! 
• Unplug the power cord and charger during

lightning storms to avoid electric shock or
fire.

• Make sure that no sharp-edged items such as
animal teeth or nails, come into contact with
the battery. 
This may cause a fire.

CAUTION!
• Do not force the connector as this may

damage the phone and/or the travel adapter.
• If you use the battery pack charger when

abroad, use an attachment plug adaptor for
the proper configuration.

• Do not remove your battery or the USIM
card while charging.
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Turning the handset
on/off

Turning your handset on
Ensure that your USIM card is in your
handset and the battery is charged. Press and
hold until the power comes on. Enter
the USIM PIN code that was supplied with
your USIM card if the PIN code request is
set to On. (Note: Please refer to page 75) 
After a few seconds you will be registered on
the network.

Turning your handset off 
Press and hold until the power goes off.
There may be a few seconds delay while the
handset powers down.
Do not turn the handset on again during this
time.

Access codes
You can use the access codes described in
this section to avoid unauthorised use of
your phone. The access codes (except the
PUK and PUK2 codes) can be changed by
using the Change codes feature [Menu
#.1.5.3].

PIN code (4 to 8 digits)
The PIN (Personal Identification Number)
code protects your USIM card against
unauthorised use. The PIN code is usually
supplied with the USIM card. When the PIN
code request is set to On, your phone will
request the PIN code every time it is
switched on. When the PIN code request is
set to Off, your phone connects to the
network directly without the PIN code.

PIN2 code (4 to 8 digits)
The PIN2 code, supplied with some USIM
cards, is required to access functions such as
Fixed dial number. These functions are only
available if supported by your USIM card.
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PUK code (4 to 8 digits)
The PUK (PIN Unblocking Key) code is
required to unblock a blocked PIN code. The
PUK code may be supplied with the USIM
card. If not, contact your network operator’s
customer service department for the code. If
you lose the code, contact your network
operator’s customer service department.

PUK2 code (4 to 8 digits)
The PUK2 code, supplied with some USIM
cards, is required to unblock a blocked PIN2
code. If you lose the code, contact your
network operator’s customer service
department.

Security code (4 to 8
digits)
The security code prevents unauthorised use
of your phone. The default security code is
set to ‘0000’ and the security code is
required to delete all phone entries and to
restore the handset to the factory settings.

Display information

No USIM idle screen
This is the initial screen of the phone that
appears when there is no USIM card installed
in the phone, or the installed USIM card is
invalid. In this screen, users can only make
emergency calls, and turn the phone off. To
turn the phone off, press and hold down

for a few seconds.

Screen structure
If there is no USIM card installed, an
animation telling you to insert a USIM card
appears. If the USIM card inserted into the
phone is invalid, an animation telling you that
the USIM card is locked appears.

Emergency call function
The right soft key is represented by
“Emergency” on the screen. Press the right
soft key or dial your emergency number
using the number keys, and then press 
to make an emergency call.
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Idle screen
The idle screen appears when you have
installed a proper USIM card and turned the
phone on.

Screen structure
Idle screen consists of the operator's name,
indicators, date and time on a background
image. You can change the wallpaper in the
Display settings menu.

Numbering screen
The numbering screen appears when a
number key is pressed in the idle screen.

Screen structure
The numbering screen consists of status
indicators, dialled number and soft menu.
Status indicators are the same as those of
the idle screen. You can change the size and
colour of the dialling font in the Display
settings menu. You can make a call while
dialling a phone number by pressing .

Soft key
You can use the soft keys for several
functions while dialling a number. Using the
left soft key, you can make a video call, send
a message to the number, save the number to
Contacts.

Handset lock screen
When the Handset lock function is selected,
you can only make an emergency call, release
the lock, and turn off the phone in this
screen. As always, you can turn the phone off
by pressing and holding for a few
seconds.

Screen structure
The screen structure of the Handset lock
screen is the same as that of the idle screen,
except that the lock message appears instead
of the idle screen.

Emergency call function
You can make an emergency call using the
right soft key. As with the No USIM idle
screen, only emergency numbers can be
dialled.
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Unlock function
If you press , a popup screen appears
asking you to input the Security code to
unlock the phone. The Security code is
configured in the Change codes (#. Settings
> 1. Phone settings > 5. Security > 3. Change
codes). If you key in an incorrect Security
Code, the phone will remain in Handset lock
status. If you key in the correct Security
code, the phone will be unlocked, and the
idle screen will be displayed. If you have
turned the phone off in the Handset lock
status, you will find the phone remains in
Handset lock status when you turn it on. 

Barring password
This service obstructs calling service in some
conditions. This condition can be edited
using the Call barring feature (#. Settings >
5. Call settings > 2. Call barring). The barring
password is required when you use the call
barring function. The password is obtained
from your network operator's customer
service when you subscribe to this service.
While this service is activated, the caller will
hear the information message that the call is
not connected because of the call barring.
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Making and answering calls

Making a voice call
1. Enter the number including the full area

code.

] To delete a digit press .
To delete all digits press and hold .

2. Press to make the call.
3. Press to finish the call, or close the

handset.

Making a call from the call logs
1. In standby mode, press and the

latest incoming, outgoing and missed
phone numbers will be displayed.

2. Select the desired number by scrolling
.

3. Press to call the number.

Making a video call
You can make a video call in a 3G covered
service area. If the called user has a 3G video
phone in a 3G covered service area, the call
will be established. You can also answer a
video call for video incoming call. To
make/answer a video call, do the following.

1. Input the phone number using the keypad,
or select the phone number from the calls
made/received lists.

] To correct mistakes, press briefly
to delete the last number, or press and
hold to delete all numbers.

2. If you do not want to use the
speakerphone, ensure you have the
headset plugged in.

3. To start the video function, press the left
soft key [Options] and select Make video
call.

] You will be notified that you will need to
close other applications to make the
video call.

Note
] To activate the speakerphone during a

call, press .
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4. Adjust the camera position if necessary.

5. Press to finish the call, or close the
handset.

Making a voice/video call from
Contacts
It is easy to call anyone whose number you
have stored in your Contacts.

1. Scroll down to access the contacts
list.

2. Scroll to the contact to make a call.

3. Press to make a voice call. Press the
left soft key and select Make video call to
make a video call. 

4. Press to finish the call.

Making international calls
1. Press and hold for the international

prefix. The ‘+’ character prefixes the
international access code.

2. Enter the country code, area code, and
the phone number.

3. Press .

Adjusting the volume
During a call, if you want to adjust the
earpiece volume, use on the left side of the
phone. In idle mode, you can adjust the key
volume using .

Answering a call
When you receive a call, the phone rings and
the flashing phone icon appears on the
screen. If the caller can be identified, the
caller’s phone number (or name if stored in
your Contacts) is displayed.

Note
] The video call may take some time to

connect. Please be patient. The
connection time will also depend on how
quickly the other party answers the call.
While the video call is connecting, you
will see your own image; after the other
party has answered, their image will be
displayed on the screen.
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1. Open the slider to answer an incoming
call.

Note
] To reject an incoming call, press or

the right soft key twice.

] If you set Answer mode as Press send
key (Menu #.5.0.4), you can answer
the call by pressing after opening
the slider.

] If the answer mode is set to Press any
key, any key will answer a call except for

.

2. End the call by closing the handset or
pressing .

Shortcut to activate vibrate
mode
You can activate the vibrate only mode by
pressing and holding down after
opening the phone.

Signal strength 
You can check the strength of your signal by
the signal indicator ( ) on the LCD
screen of your phone. Signal strength can
vary, particularly inside buildings. Moving
close to a window may improve reception.

Entering text 
You can enter alphanumeric characters 
using the keypad.
For example, storing names in Contacts,
writing a message, creating a personal
greeting or scheduling events in the calendar
all require entering text.
The following text input methods are
available with the handset.

Note
] You can answer a call while using the

Contacts or other menu features.

] When the compatible headset is
connected, you can also answer a call
using the headset key, as well as using
the phone. To reject an incoming call,
press .

] You can mute the ringtone when a call
comes in by pressing and holding the
volume down side key.
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Changing the text input mode 
1. When you are in a field that allows

characters to be entered, you will notice
the text input mode indicator in the upper
right corner of the LCD screen.

2. Press to cycle between T9Abc,
T9abc, Abc, abc and 123.

Using the T9 Mode
The T9 predictive text input mode allows you
to enter words easily with a minimum number
of key presses. As you press each key, the
handset begins to display the characters that
it thinks you are typing based on a built-in
dictionary. As new letters are added, the word
changes to reflect the most likely candidate
from the dictionary.

1. When you are in the T9 predictive text
input mode, start entering a word by
pressing to . Press one key per
letter.

T9 mode 
This mode lets you enter words with only
one keystroke per letter. Each key on the
keypad has more than one letter. The T9
mode automatically compares your
keystrokes with an internal dictionary to
determine the correct word, thus requiring
far fewer keystrokes than the traditional
ABC mode. This is sometimes known as
predictive text.

ABC mode 
This mode lets you enter letters by
pressing the key labelled with the required
letter once, twice, three or four times until
the letter is displayed.

123 mode (Number mode) 
Type numbers using one keystroke per
number. To change to 123 mode in a text
entry field, press until 123 mode is
displayed.
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] The word changes as letters are typed.
Ignore what’s on the screen until the
word is typed completely.

] If the word is still incorrect after typing
completely, press once or more to
scroll through the other word options.

Example
Press to type Good.
Press to get Home.

] If the desired word is missing from the
word choices list, add it by using the
ABC mode.

2. Enter the whole word before editing or
deleting any keystrokes.

3. Complete each word with a space by
pressing .

To delete letters, press . Press and hold
down to erase entire words.

Using the ABC Mode
Use to to enter your text.

1. Press the key labelled with the required
letter:

] Once for the first letter.

] Twice for the second letter.

] And so on.

2. To insert a space, press once. To
delete letters, press . Press and
hold down to clear the display. 

Refer to the following table for more
information on the characters available
using the alphanumeric keys.
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Note
] The characters assigned to the keys and

their order of appearance depends on
the language selected using the option
Input method. The table above provides
the characters set for English language.

Using the 123 (Number) mode
The 123 mode enables you to enter numbers
in a message(a telephone number, for
example). Press the keys corresponding to
the required digits before manually switching
back to the appropriate text entry mode.

Using the symbol mode
The symbol mode enables you to enter
various symbols or special characters. To
enter a symbol, select Options > Insert >
Symbol. Use the navigation and numeric keys
to select the desired symbol and press .

Upper caseLower case
. , ? ! ' " 1 - ( )@ / : _. , ? ! ' " 1 - ( )@ / : _

A B C 2 À Á Â Ã Ä Å Æ Ça b c 2 à á â ã ä å æ ç 

D E F 3 È É Ê Ëd e f 3 è é ê ë

G H I 4 Ì Í Î Ïg h i 4 ì í î ï

J K L 5 £j k l 5 £

M N O 6 Ñ Ò Ó Ô Õ Ö Ø OEm n o 6 ñ ò ó ô õ ö ø oe

P Q R S 7 ß $p q r s 7 ß $

T U V 8 Ù Ú Û Üt u v 8 ù ú û ü

W X Y Z 9w x y z 9

Space, 0Space, 0

Characters in the order display
Key
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2.1 Now playing
2.2 All tracks
2.3 Playlists
2.4 Song recognition
2.5 Music store

2. Music

3.1 Camera
3.2 Video recorder

3. Camera

6.1 Create new
6.2 Inbox
6.3 Drafts
6.4 Outbox
6.5 Sent messages
6.6 E-Mail
6.7 Templates
6.8 Media Album
6.9 Messaging settings

6. Messaging

7.1 Add new
7.2 Contacts list
7.3 Groups
7.4 Speed dials
7.5 Service dial numbers
7.6 Own number
7.7 Settings

7. Contacts

4. Video Call

* : Shown only if supported by the service provider

You can launch a menu by pressing briefly on the screen when it is in idle mode.
Move to the desired item and press to enter the sub-menu.
From the main menu you can also enter a sub-menu by directly pressing the corresponding
numeric key as follows. The main menu consists of the following top menus and sub-menus.
(Note: The short-cut key numbers displayed below represent the ones in List style menu.)

8.1 Homepage
8.2 Enter URL
8.3 Bookmarks
8.4 Saved pages
8.5 Browser settings
8.6 Mobile TV
8.7 Music
8.8 Games
8.9 Ringtones
8.0 Pictures
8. News
8.# Sport

8. Vodafone live!

.1 Pictures

.2 Sounds

.3 Videos

.4 Games&Applications

.5 Bluetooth data

.6 Other files

. My Files

0.1 Alarms
0.2 Calendar
0.3 Tasks
0.4 Memo
0.5 Calculator
0.6 Converter
0.7 World time
0.8 Voice recorder

0. Organiser & Tools

#.1 Phone settings
#.2 Display settings
#.3 Java settings
#.4 Messaging settings
#.5 Call settings
#.6 Contact settings
#.7 Connectivity

#. Settings

1. USIM Tool Kit/
Alarms(if SAT not
supported by USIM)

*
*
*
*
*
*
*

5.1 All calls
5.2 Dialled calls
5.3 Received calls
5.4 Missed calls

5. Calls

9.1 Games & Applications
9.2 Mobile TV
9.3 Java settings

9. Entertainment

*
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 Tool Kit

Depending on whether you have SAT support
services or not (i.e. USIM Application Toolkit)
on the USIM card, this menu (Menu 1) may
be different.
If the USIM card supports SAT services, this
menu will be the operator-specific service
name stored on the USIM card, for instance
“Special”. Please refer in that case to the
information provided with your USIM card
for further information on how to use the
related options.

If the USIM card does not support SAT
services, this menu will be Alarms.
For the Alarms menu feature, please refer to
page 67. 
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Now playing Menu 2.1

This menu will be activated when there are
some tracks currently played.

All tracks Menu 2.2

You can view the entire music files in the
phone memory.

Playlists Menu 2.3

You can create your own playlists by
choosing tracks from the All tracks menu list.

Song recognition Menu 2.4

Selecting this menu starts dialling a number
for song recognition. For further information,
please contact your service provider.

Music store Menu 2.5

Connects to the Vodafone music download
site.

Music [Menu 2]

33

Note
Additional charges may be incurred when
downloading music.
Contact your service provider for further
information.
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Camera Menu 3.1

This application enables you to take a still picture. You can take a picture in the size you want,
and use it for the address book photo, home screen and other more general purposes. 
Once taken, the picture can be sent by Message, Postcard, Email or Bluetooth.

1. Press the left soft key to access Options and set the desired environment as follows. 

] Move between the options menus by moving the scrolling bar up/down.

] Select the desired value with / and confirm the selection by pressing .

Press the to take a
picture. Press the Camera
hot key to use the AF(Auto
Focus) function.

Zoom : x1, x2 (Note: Available zoom level
depends on the size.) 
] You can zoom in with / zoom out with

in preview mode.

Brightness : From –4 to 4 at 1 intervals. 
The higher the level, the brighter the screen. 

Displays the current
camera settings.

TTakakee

OpOptionstions

ExitExit
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Menu Icon

Super fine, Fine, Standard.Quality 

Video recorder, My FilesGo to

1600X1200, 1280x960, 640x480,
320x240, Home screen, 176x144,
Contact

Size

Off, Auto, Always on, When taking a
picture 
] You can turn the camera light

on/off with in preview mode.

Light

Multishot

White

balance

You can take better pictures at night
by selecting On.

You can apply one of 9 frame effects
when taking a picture. 
(available only in case of 320x240
size)

You can delay the camera shutter
time. None, 3 seconds, 5 seconds,
10 seconds.

None, Black & White, Negative,
Sepia.

Night
mode

Frame 

Timer

Effect

Select the desired shutter sound.Sound

You can activate the mirror effect
by selecting On.

Mirror

You can switch the camera to
activate either the Internal or the
External camera. 
] You can also switch the camera

with in preview mode.

Switch

One, Three, Six, Nine (Note:
Available multishot depends on the
size.)

You can adjust the tone of the
background photo according to the
weather.
Auto, Daylight, Cloudy, Illuminate,
Indoors.

Description Menu Icon Description

Multi, CenterExposure
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2. After finishing all the settings, press the right soft key [Close].

3. Focus the camera on what you want to take and press . Press the Camera hot key to use
the AF(Auto Focus) function.

4. Press / to save the picture. It is saved in the Pictures folder of My Files. You can
directly send the picture via Message, Postcard, Email or Bluetooth by pressing the right soft
key [Send].

Note
Press to go back to the preview mode without saving the picture.
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Video recorder Menu 3.2

This application enables you to record a video clip. You can play and watch a saved video file in
this menu. Once recorded, a video clip can be sent by Message, Email or Bluetooth.

1. Press the left soft key to access Options and set the desired environment as follows. 

] Move between the options menus by moving the scrolling bar up/down. 

] Select the desired value with / and confirm the selection by pressing .

37

Zoom : x1, x2 (Note: Available zoom level
depends on the size.) 
] You can zoom in with / zoom out with

in preview mode.

Brightness : From –4 to 4 at 1 intervals. The
higher the level, the brighter the screen. 

ExitExit

RRec.ec.

OpOptionstions

Displays the current
video recorder
settings.

Press to start
recording. You can also
start recording using .
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2. After finishing all the settings, press the
right soft key [Close].

3. Focus the camera on what to record and
press to start recording. And press

to stop recording.
] You can pause the recording by pressing

the left soft key [Pause].

4. Press to save the video clip. It is
saved in the Videos folder of My Files. 

You can directly send the video clip via
Message, Email or Bluetooth by pressing
the right soft key [Send].

Menu Icon

Super fine, Fine, StandardQuality 

Camera, My FilesGo to

320x240, 176x144, 128x96Size

Off , Always on, When recording 
] You can turn the camera light

on/off with in preview mode.

Light

White

balance

You can take better pictures at night
by selecting On.

None, Black & White, Negative,
Sepia

Night
mode

Effect

Select the desired recording time.

MMS, 30 secs, 1 min, 2 mins, 
5 mins, 60 mins

Duration

You can activate the mirror effect
by selecting On.

Mirror

You can switch the camera to
activate either the Internal or the
External camera. 
] You can also switch the camera

with in preview mode.

Switch

You can adjust the tone of the
background photo according to the
weather.
Auto, Daylight, Cloudy, Illuminate,
Indoors.

Description

Decide whether to record the sound
or not.

Sound

Note
Press to go back to the preview
mode without saving the video clip.
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You can make a video call using this menu. 

1. Enter the number you want to dial.

] You can key in the number.

] You can select the number from Contact
using the left soft key [Contacts]. 

] You can find the number from call logs
by pressing [Calls].

2. Press the right soft key [V-Call] to make a
video call.

During a video call
When you are in a video call, the screen will
show the contact's name and duration of call,
contact's image, volume indicator, video
control panel, and your image.

You can access the following option menus
by pressing the left soft key [Options].

] Mute/Unmute

] Speaker on/off

] Bluetooth/Handset talk (When the
Bluetooth headset is connected)

] Private/Show mode

] Hold/Resume

] Capture

] View sender number

] Settings

] End call

Receiving a video call
When a video call is received, the caller's
information is displayed as following.

] Picture/Animation: Displays picture ID,
graphic image configured in Contacts, or
default animation indicating the incoming
call.

] Caller's name and number: Shows
incoming caller's number. If the number is
stored in Contacts, displays the name of
the contacts.

Picture ID and animation setting is used in
the order of Contacts, video file used in
Group ringtone, and video file used in Profile.

Video call [Menu 4]

39
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Also, sound can be set for the incoming
video call. The sound setting is used in the
order of Contacts, Group ringtone, and
Profile.

You can accept the incoming call by pressing
the left soft key [Accept]. 

The incoming call ringing can be silenced by
pressing the right soft key [Silent]. It can be
also silenced by long press on on the left
side of the phone.

When ringing is silenced, press the right soft
key [Reject] to reject the call.
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You can check the record of missed, received,
and dialled calls only if the network supports
Caller Line Identification (CLI) within the
service area.

The number and name (if available) are
displayed together with the date and time at
which the call was made. You can also view
call times.

All calls Menu 5.1

Allows you to view the missed, received, and
dialled call records. You can make a call, or
send a message to the number you have
selected from the records. You can also save
the number in Contacts.

Dialled calls Menu 5.2

Allows you to view dialled call records, make a
call, send a message, and save the number in
Contacts.

Received calls Menu 5.3

Allows you to view received call records, make
a call, send a message, and save the number
in Contacts.

Missed calls Menu 5.4

Allows you to view missed call records, make
a call, send a message, and save the number
in Contacts.

Calls [Menu 5]

41
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Create new Menu 6.1

Message (Menu 6.1.1)

You can write and edit a message containing
a combination of text, image, video and
audio.

1. Enter your message in the Message field.

Option menus in Message field

] Insert: You can perform the following
actions:

1. Pictures: You can insert an image.
(One image per slide)

2. Take Picture: The camera module
opens and you can take a picture. The
picture is then inserted in the message
window. (One picture per slide).

3. Videos: You can insert a video clip.
(One video clip per slide)

4. Take Video: The video recorder
module opens and you can record a
video. The recorded video is inserted
in the message. (One video clip per
slide)

5. Sounds: You can insert a sound file.
(One sound per slide)

6. Record Sound: The voice recorder
module opens and you can record a
sound. The recorded sound is inserted
in the message. (One sound per slide)

7. Contact details: You can add a name
and/or a number stored in the
Contacts. Make your selection to send
either the Name, Number or Name &
Number and press . The Contacts
list opens and you can search the
desired contact to be inserted.

8. Templates: You can insert a text
template saved on the phone. 
After selecting one, press . 
The selected template is inserted into
the Message window.

9. Cc: Select this to insert Cc.

0. Subject: Select this to insert a
subject.

. New slide: Select this to add a new
slide.

#. Symbol: You can insert symbols.
After entering the corresponding
number keys, press .
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] Add recipients: You can add recipients
from your Contacts or enter the number
directly.

] Send: Select this to send the created
message.

] Save to drafts: Select this to save the
message to drafts.

] Input method: Select the desired
dictionary mode.

] Add to dictionary: You can add a word
to the dictionary.

] Cancel: Select this to cancel editing.

2. Press the right soft key [Continue]. You
can add recipients from Contacts or enter
the number directly. (You can enter up to
10 numbers.) 

Option menus in To field

] Add recipients: You can add recipients
from your Contacts or enter the number
directly.

] Send: Select this to send the message.

] Save to drafts: Saves the message to drafts.

] Cancel: Select this to cancel editing.

3. Press the right soft key [Send] to send the
message. The message will automatically
be saved in the Sent messages folder. If
the message has not been sent, it will
remain in the Outbox with a failed status.

Postcard (Menu 6.1.2)
(Note: This service is not available in all countries. Please
contact your service provider for further information.)

1. Key in a message.

2. Press the right soft key [Insert]. You can
insert a stored image or newly taken
picture.

3. After an image is inserted, the format will
be changed to Postcard format. 

4. Fill out the fields: Name, Additional info,
Address, Post code, City, State, Country.

5. Press the right soft key [Send] to send the
created postcard.

43
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E-Mail (Menu 6.1.3)

To send/receive an email, you should set up
the email account. (Refer to page 52-54 for
how to set up an Email account.)

1. Enter the email addresses of the recipients
in the To, Cc, Bcc fields. You can search
the Contacts by pressing .

2. Move the cursor to the Subject field and
key in the subject. 

3. You can enter the message contents by
moving the cursor to the Message field.

4. Use the following functions by using the
left soft key [Options].

] Insert: Select this menu to insert special
characters, templates, and contacts. It is
also possible to attach multimedia files
(pictures, videos and sounds).

] Add recipients: Select this menu to
insert email addresses saved in Contacts.
(Only shown in Option menu when
cursor is located in To/Cc/Bcc fields.)

] Send: Sends the created email.

] Save to drafts: Select this menu to save
the message in Drafts.

] Preview: You can preview the created 
email before sending it.

] View attachment: Shows the attached
files. (This item is only available when
some files have been attached.)

Note
• Enter the reference email address to

forward the email in Cc(Carbon copy)
field.

• Enter a hidden reference email address to
forward the email without forwarding
information in Bcc(Blind Carbon Copy)
field.

• Only valid email addresses are allowed for
the recipient (To), reference address (Cc)
and hidden reference address (BCC)
fields. When an email address has been
specified, another field where you can
specify another address appears. You can
specify up to 20 recipients for the To
and Cc address fields and 10 recipients
for the BCC address field.
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] Input method: Select the desired
dictionary mode.

] Add to dictionary: You can add a new
word to the dictionary.

] Set mail priority: You can configure the
priority of the email you wish to send.

] Cancel: Exits the email composer.

5. When you have finished writing an email,
press the right soft key [Send] to send 
the email.

Inbox Menu 6.2

1. You can view saved messages. Select a
message and then press to view the
message.

2. You can view the previous or next message
by using .

3. To view a multimedia message
(Notification), select Retrieve in the
message notification view screen. The
message will then begin transmission, and
you can view the message after it is
complete.

You can use the following functions by using
the left soft key [Options] in the Inbox.

] View: Opens the selected message.

] Reply: Creates a reply to the sender or
all recipients of the selected message.

] Forward: Forwards the selected message. 

] Make voice call: You can make a voice
call.

] Make video call: You can make a video
call.

] Delete: Deletes the current message.

] Create new message: You can write a
new message or an Email.

] Mark/Unmark: You can select one or
more messages for multiple deletion.

] Filter: Displays messages by desired
message types.

] Copy: In case of SMS, you can copy the
message into handset or USIM.

45

Note
Not supported for multimedia message
(Notification) and WAP push messages.
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] Move: In case of SMS, you can move the
message into handset or USIM.

] Message info.: You can check the
message type, date and time and where
it is saved.

Drafts Menu 6.3

You can view saved messages. Select a
message and then press to edit the
message.
After saving the message in drafts, you can
use the following functions by using the left
soft key [Options].

] Edit: You can edit messages.

] Delete: Deletes the selected message.

] Create new message: You can write a new
message or an Email.

] Mark/Unmark: You can select one or
more messages for multiple deletion.

] Filter: Displays messages by desired
message types.

] Message info.: You can check the message
type, date and time and where it's saved. 

Outbox Menu 6.4

The Outbox is a temporary storage place for
messages waiting to be sent. Failed messages
are also placed in Outbox. For example,
Emails will be placed in Outbox if the Email
account is not correctly configured.

1. Select a message and then press to
view the message.

2. You can use the following functions by
using the left soft key [Options].

[For sending / waiting messages] /
] Create new message: You can write a new

message or an Email.

] Cancel: You can stop sending/waiting
status.

] Message info.: You can check the message
type, date and time and where it's saved. 

Note
You can check the saved Emails in Email
[Menu 6.6].
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[For sending a failed message] /
] Resend: Resends the selected message.

] Forward: Forwards the selected message.

] Edit: You can edit the selected message.

] Delete: Deletes the current message.

] Create new message: You can write a new
message or an Email.

] Mark/Unmark: You can select one or
more messages for multiple deletion.

] Message info.: You can check the message
type, date and time and where it's saved.

Sent messages Menu 6.5

Shows the messages you sent (Message/
Postcard/ Email).

[Options]

] View: Opens the selected message.

] Reply: Creates a reply to sender or all
recipients of the selected message.

] Forward: Forwards the selected message.

] Delete: Deletes the current message.

] Edit: You can edit the selected message.

] Create new message: You can write a new
message.

] Save number: Save the sender's number.

] Mark/Unmark: You can select one or
more messages for multiple deletion.

] Filter: Displays messages by desired
message types.

] Copy: In case of SMS, you can copy the
message into handset or USIM. 

] Move: In case of SMS, you can move the
message into handset or USIM.

] Message info.: You can check the message
type, date and time and where it is saved.

E-Mail Menu 6.6

Viewing email message list

1. Select an email account and then press
to view the received email list.

2. Using the right soft key [Retrieve], you

47
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can retrieve a new email list from the email
server of the selected account.

3. In email list, you can use the following
functions by using the left soft key
[Options].

] View: Opens selected email. 

] Reply: Creates a reply to the selected
email.

] Forward: Forwards the selected email
message to others.

] Retrieve: Retrieves new email messages.

] Delete: Deletes the email.

] Create new message: Creates a new
message or Email.

] Save address: Save sender's address to
Contacts.

] Mark/Unmark: Use mark/unmark
option for multiple deletion.

] Set as read/unread: You can set the
selected email to read or unread.

] Message info.: Brief information on the
message including size, type, date, time
and filenames.

Viewing an email message
1. Select one of the received emails and

press the Open key to receive the
contents of the email.

2. The contents of the received email are
automatically displayed in the View screen.

3. You can view the contents of the previous
or next email by using .

4. In the email View screen, you can select
the following functions by using the left
soft key [Options].

] Reply: Creates a reply to the selected
email. 

] Forward: Forwards the selected email
message to others.

] Delete: Deletes the email.

] Save address: Saves the sender's
address to Contacts.

] Create new message: Creates a new
message.

] Use: Extracts the number, email address
or Web address from email message.

] View attachment: Shows the attached
file.

KU970_Eng(AUS)_0312  07.03.12  11:4 AM  Page 48



M
essaging

] View to address: Shows the email
addresses of the recipients and
reference (Cc).

] Message info.: Brief information on the
message including size, type, date, time
and filenames.

Templates Menu 6.7

Text templates (Menu 6.7.1) 

You can add, edit, and delete frequently 
used useful phrases using the left soft key
[Options].

Multimedia templates (Menu 6.7.2)

You can create, edit and view available
templates when creating multimedia
messages. Five types of template (Birthday,
Greeting, Holiday, Thanks, Sorry) are saved
by default.

The following options are available.

] Add new: You can create a new multimedia
template.

] Write multimedia message: Creates 
a multimedia message with the selected
template.

] View: Displays the selected template.

] Edit: Edits the selected template.

] Delete: Deletes the selected template. 

] Cancel: Goes back to previous menu.

Media Album Menu 6.8
(Note: This service is not available in all countries. Please
contact your service provider for further information.)

Accesses the remote media album.

Messaging settings Menu 6.9

SMS (Menu 6.9.1)

You can configure text message related
options.

49

Note
Depending on your service provider, useful
phrases are saved as a default.

KU970_Eng(AUS)_0312  07.03.12  11:4 AM  Page 49



Messaging

50
M

essaging

1. Text message centre: Input the address
of the Text message centre.

2. Delivery report: By enabling this option,
you can verify whether your message has
been sent successfully.

3. Validity period: This network service
allows you to set how long your text
messages will be stored at the message
centre.

4. Message types: Text, Voice, Fax, X.400,
Email 
Usually, the type of message is set to Text.
You can convert your text into alternative
formats. Contact your service provider for
the availability of this function.

5. Character encoding: Auto/ Default
alphabet/ Unicode.

] Auto(default): Message with single
byte character is normally encoded in
Default alphabet(GSM7). Message with
double-byte character is automatically
encoded in unicode(UCS2).

] Default alphabet: Message with even
double byte character is encoded in
single byte. Please note that double
byte characters with accent may be
converted into single byte character
without accent.

] Unicode: Message is encoded in double
byte. Please note that you may be
charged double.

6. Send long text as: Select a long text
message as Multiple SMS or MMS.

MMS (Menu 6.9.2)

You can configure Multimedia message
related options.

1. Retrieval mode: You can set the retrieval
mode using Home network and Roaming
network respectively. If you select
Automatic, you will receive multimedia
messages automatically. If you select
Manual, you will only receive a notification
message in the inbox and then you can
decide whether to download multimedia
messages or not.
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2. Delivery report: Allows you to determine
whether to request a delivery confirmation
mail to a recipient, and whether to allow
sending a delivery confirmation mail to a
sender.

] Request report: Determines whether to
request a delivery confirmation mail for a
Multimedia message.

] Allow report: Determines whether to
allow sending a delivery confirmation mail
for a delivery confirmation mail request.

3. Read reply: Allows you to determine
whether to request a read confirmation
mail to a recipient, and whether to allow
sending a read confirmation mail to a
sender.

] Request reply: Determines whether to
request a read confirmation mail for a
Multimedia message.

] Allow reply: Determines whether to allow
sending a read confirmation mail for a
read confirmation mail request.

4. Priority: You can select the priority level
of the messages (Low, Normal and High).

5. Validity period: Allows you to configure
the term of validity for a message when
transmitting a multimedia message. The
message would be saved in the multimedia
message server only for the configured
term.

6. Slide duration: Allows you to configure
the duration of each page when writing a
message.

7. Delivery time: Configures the delivery
time of message to the recipient. The
Multimedia message centre will deliver the
message after the delivery time.

8. Multimedia msg. centre: Allows  you to
configure network information such as the
MMSC and the WAP gateway, to send a
multimedia message.

Using the left soft key [Options], you can
activate, add or delete a profile. A profile
name selected by a checkmark is the
currently configured value. You can view
and edit the contents of the profile in edit

51
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mode by pressing the right soft key [Edit].
The edit screen also appears when
creating a new profile under Options. The
meaning of each item is given below.

] Title: Profile name.

] MMSC URL: Enter the multimedia
message centre URL.

] MMS Proxy: Enter the WAP gateway
address and port number.

] Connection mode: Select one of the
connection mode. (TCP with Proxy, TCP
without Proxy, UDP)

] Access points: Specify the access point
name. (see WAP connection settings.)

Press the right soft key [Done] to save the
changes and complete Multimedia msg.
centre setting.

E-Mail (Menu 6.9.3)

You can configure settings for receiving and
transmitting emails.

1. Vodafone Mail: Access to Vodafone Mail.
(Note: This service is not available in all countries.
Please contact your service provider for further
information.)

2. Allow reply email: Determines whether to
allow sending a read confirmation mail for
a read confirmation mail request.

3. Request reply email: Determines whether
to request a read confirmation mail.

4. Auto retrieve: You can configure Auto
retrieve to retrieve emails automatically
from the incoming mail server. When a new
email arrives, an icon appears at the top of
the screen. You can select the auto
receiving time slot to Off, 15 minutes, 
30 minmutes or 1 hour. 
Please note that additional charges may
be incurred using the Auto retrieve
feature.
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5. Include message in Fwd. & Reply:
Determines whether to include the
received message when you forward the
message or reply to it.

6. Signature: You can configure a text
signature to be attached to the end of an
email. The configured signature text is
automatically or manually attached to the
end of the email when it is sent.

7. Priority: You can select the priority level
of Emails (Low, Normal and High).

8. Email accounts: You can create or
configure an email account including the
email server and user ID. You can edit a
selected email account by pressing the
right soft key [Edit]. You can select an
email account to be used to send an email
using . You can select the following
functions using the left soft key [Options].

] Add new: Create a new email account.

] Edit: To edit the selected email account.

] Activate: Activates the selected account
for outgoing mail.

] Delete: Deletes a selected email
account. All the emails included in the
account will be deleted.

Creating a new email account

1. Select Add new from the Email account
menu options.

2. The following items need to be configured.

53

Enter the user name of the email
account.

Username

Enter a title.Title

Enter the email account password.Password

Enter the email address for outgoing
mail.

Email address

Enter the email address to reply to
your email.

Reply email
address

Enter the outgoing email server.Outgoing mail
server

Enter the incoming email server.Incoming mail
server

Enter the mail server port number. In
general, the SMTP (Outgoing mail
server port number) is 25.

SMTP port
number

Enter the mail server port number. In
general, the incoming mail server port
number is 110(POP3) or 143(IMAP4).

Incoming server
port
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complete the email account configuration. 

Editing an email account
1. Select a desired email account from the

email account list and press the right soft
key [Edit].

2. You can edit desired fields by moving the
cursor up and down.

3. When configuration is complete, press the
right soft key [Done] to complete the
email account configuration.

Maximum receive
size

Decide whether the outgoing mail
server to require authentication or not
using . When the SMTP
authentication is set to On, you can
enter the SMTP Username and SMTP
Password for SMTP authentication.

SMTP
authentication

Decide whether to activate Auto
retrieve or not using  . You can
set the auto receiving time slot using
the Auto retrieve [Menu 6.9.3]. 
(See page 52.)

Auto retrieve

Select an access point to connect to
the Internet. You can select a
configured access point using .

Access points

Select where to save the sent mails
(when the mailbox type is set to
IMAP4). When the mailbox type is
POP3, sent mails are always saved into
handset.

Select the email inbox type either
POP3 or IMAP4 using .

Save to server

Save sent mail
into

Mailbox type

Determine whether to leave a copy of
messages on the incoming server or
not using . When the mailbox
type is set to IMAP4, a copy of
messages are always saved to the
server.

Select the maximum email receive size
using . The permissible maximum
receive size is no more than 1MB.

Decide whether to activate APOP
secure login or not using . 
When the mailbox type is IMAP4,
APOP secure login is always set to
OFF.

APOP secure
login

Note
When you try to change the mailbox
type, all emails downloaded before
would be deleted.
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Info. service (Menu 6.9.4)

] Cell broadcast: You can set the reception
status.

] Channels: You can add or modify the
channels.

] Languages: You can select the language
you want by pressing . Then, the info
service message will be shown in the
language that you have selected.

Service message (Menu 6.9.5)

You can configure the service message
receipt option.

55
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Add new Menu 7.1

You can register a new contact address. You
can enter the name, different phone numbers
and email addresses of a new contact. You
can also assign the contact to groups,
include an image or avatar, assign a specific
ringtone and even enter a memo for the
contact. Other available fields include Home
page URL, Home address, Company name,
Job title and company address. You can enter
and manage contact addresses depending on
the memory usage.

Contacts list Menu 7.2

Performs the contact address search
function. The search operation is performed
based on a name as a default. The current
search method and results found are
displayed in the Search window. You can
make a phone call or send a message to the
selected phone number. A Contacts search
can be performed based on the phone
number or group information.

Groups Menu 7.3

Using this menu you can manage group
information (both stored in the Handset and
the USIM). In the handset memory, there are
4 default groups: Family, Friends, Colleagues
and School. You can add, edit and delete
groups. When a ringtone for a number is not
specified, a call from the number sounds the
group ringtone assigned to the number for
the group.

Speed dials Menu 7.4

Using this menu you can manage speed dials.
Speed dials are configured between 2-9. You
can register speed dials for a specific contact
address up to 5 different numbers, and a
contact address may have multiple speed
dials.

Service dial numbers Menu 7.5

You can view the list of Service Dialling
Numbers (SDN) assigned by your service
provider (if supported by the USIM card).
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Such numbers include emergency, directory
enquiries and voice mail numbers. After
selecting a service number, press to dial
the service. 

Own number Menu 7.6

Allows you to display your phone number in
the USIM card. You can save own numbers
being used in the USIM card.

Settings Menu 7.7

View contacts from (Menu 7.7.1)

Select which contact information shall be
displayed (from handset memory, from USIM
card or both). All is the default setting. 

Show image/avatar (Menu 7.7.2)

Select whether to display image/avatar or
not.

Copy all (Menu 7.7.3)

You can copy contacts from the phone
memory to the USIM or from the USIM to
the phone memory. You can copy all items or
one at a time.

Move all (Menu 7.7.4)

You can move contacts from the phone
memory to the USIM or from the USIM to
the phone memory. You can move all items or
one at a time. 

Clear contacts (Menu 7.7.5)

Clears all contact information. You can delete
all contacts saved in the mobile phone
memory as well as on the USIM card.

57
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Homepage Menu 8.1

You can launch the web browser and access
the homepage of the web service provided
by Vodafone.

] You can also directly access Vodafone live!
by pressing the left soft key in idle mode.

Enter URL Menu 8.2

Enter address (Menu 8.2.1)

You can manually enter a URL address and
access the associated web page. 

] To enter a symbol, press or the right
soft key [Insert symbol] to display the
Symbol table. 

] To switch input text mode, press .

Recent pages (Menu 8.2.2)

Shows the recently-browsed pages.

Bookmarks Menu 8.3

You can store frequently accessed or
favourite URLs/Pages. Open, Send, Add
new, Edit, Mark/Unmark or Delete
operations can be performed on Bookmarks.
Several preconfigured URLs are stored as
bookmarks.

Adding a new bookmark 
1. Press the right soft key [Add].

2. Enter the title and associated URL
information.

3. Press the right soft key [Done] to save.

Connecting to a desired bookmark 
Press or select Open from the
Options menu. 

Sending the bookmark to others 
Select Send from Options menu. You can
send it via Message or Email. 

Deleting a bookmark
Select Delete from Options menu. You can
delete multiple bookmarks using the
Mark/Unmark option.
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Saved pages Menu 8.4

The phone can save the page on display as
an offline file. Up to 20 pages can be saved.

Browser settings Menu 8.5

You can change the settings for browser
display, security, and certificates.

Profiles (Menu 8.5.1)

Select the appropriate profile by pressing 
. This will activate the profile to initiate

the browser launch.

Security (Menu 8.5.2)

Certificates
If stored, a list of root/ca certificates required
for WTLS/TLS can be found here.
Certificates can be viewed from the list.

Session clear
Secure (WTLS/TLS) session data can be
cleared using this option. Session data
should be cleared to establish a new secure
session.

Character encoding (Menu 8.5.3)

Sets the browser default character set to one
of the following: 

Automatic, English(ASCII), English(ISO),
English(LATIN), Unicode(UCS2 BE),
Unicode(UCS2 LE), Unicode(UCS2 Auto),
Unicode(UTF-16 BE), Unicode(UTF-16
LE), Unicode(UTF-16 Auto), Unicode(UTF-
8).

Scrolling control (Menu 8.5.4)

Allows you to set the scroll speed by
selecting the number of lines to scroll. 
Select one from Small(1 line), 
Medium(2 lines), Large(3 lines).

59
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Show image (Menu 8.5.5)

Allows you to enable or disable the image
display during browsing.

Cache (Menu 8.5.6) 

Enabling Cache allows you to store accessed
pages to your phone. Once a page has been
stored in the Cache it will greatly enhance
the page loading speed on subsequent
browsing of the same page.

Cookies (Menu 8.5.7)

Enabling Cookies allows you to store cookies
sent from the server. Disabling this function
will prevent cookies from being stored on
your phone.

JavaScript (Menu 8.5.8)

Select whether to turn JavaScript On or Off.

Reset settings (Menu 8.5.9)

Select this to reset your phone to its default
browser configuration.

Note
Enabling this function will delay displaying
images until the completion of
transmission. Disabling this function will
prevent the browser from downloading
images from the server, thus allowing faster
transmission.
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Games & Applications
Menu 9.1

You can easily download games and other
applications in this menu. It has two folders,
Games and Applications, as default (There
might be no Applications folder in some
countries). Each folder has an embedded link
for downloading games or applications.
Please note that additional costs may be
incurred when using online services. You can
create a folder using the left soft key
[Options].

Mobile TV Menu 9.2

You can access Mobile TV by selecting this
menu. 

Java settings Menu 9.3

Activating a profile

1. Move the cursor to the profile which you
would like to activate.

2. Press or the left soft key Options
menu.

Adding a new profile 

1. Select Add new from the Options menu.
The following items need to be configured.

2. Press the right soft key [Done] to save any
configuration changes.

You can edit or delete a profile by selecting
Edit and Delete from Options menu.

Entertainment [Menu 9]
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Enter an account name for the profile.Service name 

Choose from the given list of
connection modes. (Default is TCP
with Proxy)

Connection
mode 

Enter the WAP Gateway IP address
provided by the operator. (e.g. 195.
115. 025. 129)

IP address

Port details are provided by the
operator, depending upon the
Connection mode.

Proxy server
port 

Choose from the given list of access
points. (For more details on adding or
editing a new access point, refer to
page 94.)

Access point
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Pictures Menu .1

The Pictures folder consists of embedded
links for downloading pictures through the
Internet and Default images.
Pictures taken using the camera are stored in
the Pictures folder and you can create new
folders to manage them. You can also save
selected files as animated Gifs and send
multiple files to other people.

When a file is selected, the following options
will be displayed by pressing the left soft key
[Options].

] View: You can view the selected picture.

] Create new folder: You can create a new
folder within the folder currently selected.

] Send: You can send the selected image via
Message, Postcard, Email or Bluetooth.

] File

- Move: Enables the file to be moved to
other folder.

- Copy: Enables the file to be copied to
other folder.

- Rename: You can rename the image.

- Edit: Enables the image to be edited.

- Make GIF animation: You can create an
animated GIF file with different photos
(up to 10 files of 240X320 resolution
with a 2Mbyte file size limit for display).

- Info.: Shows information on the selected
image file.

] Delete: Deletes the selected image.

] Mark/Unmark: Using the Mark function,
you can send, delete, move and copy
multiple files.

] Main display: You can set an image as the
screen theme (Home screen, Outgoing call,
Start up image, Power off image).

] Slide show: You can start a slide show.

] Sort by: You can sort the files by name,
date, or file type.

] List view/Grid view: You can view the
images as a List view or Grid view.

] Memory status: You can view the memory
status.
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Sounds Menu .2

The Sounds folder consists of embedded
links for downloading ringtones and music as
well as folders containing the Voice
recordings and Default sounds. Here you can
manage, send or set sounds as ringtones.

Videos Menu .3

Here you can manage or send downloaded or
captured videos clips.

The following are available using the left soft
key [Options] in the Video list.

] Play: Plays the video.

] Create new folder: You can create a new
folder.

] Send: You can send the selected video clip
via Message, Email or Bluetooth if not
protected by Digital Rights Management
(DRM).

] File

- Move: Moves the file into handset
memory.

- Copy: Copies the file in handset memory.

- Rename: You can rename the video.

- Info.: Shows information on the selected
video file.

] Delete: Deletes the selected video.

] Mark/Unmark: Using the Mark function,
you can send, delete, move and copy
multiple files.

] Sound theme: You can set a video as the
voice ringtone or video ringtone.

] Sort by: You can sort files by name, date,
or file type.

] List view/Grid view: Displays the video
files as a List view or Grid view.

] Memory status: Displays the memory
status.

63
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You can view a video using the video player.
Video files are displayed in the list as
thumbnails. You can select a desired video by
using the . Select a desired video and
select Play to view the recorded video.

Select the right soft key [Send] to attach the
selected video to a message, Email or
Bluetooth.

When option 1. Play is selected, the video
clip will be played with the Media Player. To
pause the playback, press during the
playback. To resume the paused playback,
press once again.

To capture the screen shot, press the right
soft key [Capture] when the playback is
paused.

To view the current playback in full screen,
press the right soft key during the playback.

To return to the previous screen size, press
the right soft key once again in full screen
mode.

When viewing video clips in the Media Player,
the following options are available:

] Pause/Play: You can play or pause playing
a file for a moment.

] Send: You can send the video via Message,
Email or Bluetooth if the file is not
protected by Digital Rights Management
(DRM).

] Go to list: Goes back to the list.

] Delete: Deletes the selected video.

] Sound theme: You can set a video as the
voice ringtone or video ringtone.

] Wide view: You can view the video in wide
view mode.

] Mute/Unmute: If the Volume is set to
more than 0, Mute mode is activated and if
the Volume is set to 0, the Unmute mode is
activated. 

] Capture: You can save what is on the
paused screen as an image file (only
possible in Pause mode).

] Set repeat: You can set the repeat option
(None/Current file/All files).
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] Move to  

- Previous file: Plays the previous video file.

- Next file: Plays the next video file.

] File info.: You can check information on
files being played(File name, Size, Date,
Type, Duration, Protection).

Games & Applications Menu .4

You can easily download games and other
applications in this menu. It has two folders,
Games and Applications, as default (There
might be no Applications folder in some
countries).

Each folder has an embedded link for
downloading games or applications. Please
note that additional cost may be incurred
when using online services. You can create a
folder using the left soft key [Options].

Bluetooth data Menu .5

The files received using Bluetooth are saved
in this folder. You cannot create a sub-folder
within the Bluetooth data folder.

You cannot copy or move files that are not
managed by My Files.

The options displayed depend on the type of
file selected. For instance, in case of an
image, the following functions are supported.

] View/Edit/Move/Copy/Delete/Rename
file(s).

] Mark/Unmark one or all file(s).

] Send a file via MMS, Email or Bluetooth if
not protected by Digital Rights
Management (DRM).

] If relevant, you can set an image as the
screen theme (Home screen, Outgoing call,
Start up image, Power off image).

] If relevant, start or set (normal or full
screen, at what pace) a slide show.

] If relevant, create an animated GIF file with
different pictures.

] Sort the files by name, date or file type. 
65

Note
For the image files of which resolution is
640x480 or above, you can send them
via Postcard.
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] Memory info.

] View file information.

Other files Menu .6

Other files except pictures, sounds, videos,
games & applications are stored in this
folder. 
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Alarms Menu 0.1

If you set the alarm, the appears on the
indicator bar. The specified alarm sounds at
the scheduled time. Press to stop the
alarm, and the alarm is released. Press the
right soft key [Snooze] and choose the
snooze interval. The alarm sound stops and
resumes after the selected Snooze duration.
You can configure up to 5 alarms.

1. Select your desired alarm to configure in
the alarm list. If there is no alarm, press
the right soft key [Add] to add a new
alarm.

2. Set/Cancel alarm: Set or cancel the
alarm using the options for specifying
whether the alarm is on or by choosing
the alarm time.

3. Input alarm time: Input your desired
alarm time by specifying Hour and Minute.
Choose either ‘AM’ or ‘PM’ which is visible
if 12 hour format is specified for the
phone.

4. Select repeat mode: Select the desired
repeat mode using / or select the
desired one from the list by pressing .

5. Select bell: Select the bell to ring at the
alarm time using / or opening
the list by pressing .

6. Input memo: Input alarm name.

7. Snooze: You can set the snooze duration
for the alarm.

8. When you have finished setting the alarm,
press the right soft key [Done].

Calendar Menu 0.2

Schedule inquiry and search

1. Reference by Months
You can refer to your schedule by months.
The cursor is on the current date, and the
registered date is marked. 

Organiser & Tools [Menu 0]
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Note
The alarm will go off even when the phone
is switched off.
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The schedule saved for the date where the
cursor is located is represented by an icon.
Pressing the shortcut key moves to the
previous year and pressing move to the
next year and pressing moves to today.
Pressing moves to the previous month,
and moves to the next month. Pressing

moves to the weekly calendar, and 
moves to the monthly calendar. You can move
the date scrolling .
2. Reference by Days

Pressing in the reference by month
moves to reference by day where you can
refer to your schedule by days. You can
refer to the moving date tab using /

. As a search result, brief
schedule contents, repetition set up
configuration, and alarm set up
configuration are displayed. You can send
the schedule to another phone or an
Internet site through SMS(Text message)
or MMS(Picture message) or Email or
Bluetooth.

3. Detailed reference
You can refer to a detailed schedule, that
is the whole contents of the schedule
configured by the user. You can send the
schedule to another phone or an Internet
site through SMS(Text message) or
MMS(Picture message) or Email or
Bluetooth using the left soft key
[Options].

Search schedule

You can add a schedule. You can configure
the start date, end date, start time, end time,
contents, type of schedule, repetition, alarm
of the schedule.

] Set type: Appointment, Anniversary,
Birthday, Others

] Set repeat: Once, Daily, Weekly, Monthly,
Annually, User setting

] Set alarm: No alarm, On time, 15 mins
before, 30 mins before, 1 hour before, 
1 day before, 3 days before, 1 week before
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Delete schedule

1. Previous entries

You can delete all elapsed schedules using
this function.

2. All entries

You can delete all saved schedule contents
using this function.

Set up and release holiday

You can set up or release user holidays. Press the
left soft key [Options] and select Set holiday.
The selected date will be displayed in red.

To release the holiday, press the left soft key
[Options] and select Reset holiday.

Schedule notification

If the user has configured the alarm setting,
the specified alarm sound will ring. If the
notification time is before the schedule start
time, you can set up the alarm again.

Tasks Menu 0.3

You can view, edit and add tasks to do. Tasks
are displayed in time order. Tasks that have
been completed or not completed are
displayed in different ways.

Add

To add a task, press the right soft key [Add]
in the Tasks list management screen. Then
input the date, description and priority for
the task.
When you have finished entering the data,
press the right soft key [Done] to save the
new task.

Detailed view and Edit

To view detailed task contents, locate the
cursor on the desired item in the Tasks list,
and then press . You can edit and
delete a task using the left soft key
[Options]. You can also delete multiple or all
tasks at once using the Mark/Unmark
option.
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Set job status

Tasks set as finished are displayed as crossed
out below the unfinished tasks in the Tasks
list. You can set Finished tasks to Not
finished by selecting Option.

Memo Menu 0.4

Using the memo management function, you
can view and manage saved memo contents,
and add new memo.

Add memo
To add a new memo, press the right soft key
[Add]. Enter the contents of the memo. You
can save the memo to the list by pressing the
right soft key [Done].

Edit and delete memo
Highlight the desired memo and press 
to view its contents. You can edit or delete
the contents of a memo using the left soft
key [Options]. You can return to the memo
management screen by pressing . You
can select Multiple or All memos using the
Mark/Unmark option and then delete a
memo by pressing the right soft key [Delete].

Calculator Menu 0.5

The calculator module allows you to
perform basic arithmetic functions such as
addition, subtraction, multiplication, and
division as well as some scientific functions.

1. Press the left soft key [Options].

2. Select the appropriate function.

You can enter numbers by using the number
keys, and the operators by using 
. You can enter a decimal point by pressing

. Whenever you press , characters
are sequentially deleted in reverse order.
Whenever you hold down, all the
characters are deleted in reverse order in one
go.

When calculation is complete and the result
is displayed on the screen, pressing a number
clears the previous result and the calculator
waits for new input, even if you did not press
the right soft key [AC]. When calculation is
complete and the result is displayed on the
screen, pressing a symbol saves the result
into the symbol, and continues calculation.
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Converter Menu 0.6

Using this menu, you can convert Currency,
Surface, Length, Weight, Temperature,
Volume and Velocity.

1. Select the menu you want to convert.

2. You can select the unit you want to
convert by pressing [List].

3. Move to the convert unit section and
select the unit you want to convert to by
pressing [List].

4. Input numbers using the numeric keys.
Conversion is calculated automatically.
(Note: You can input a decimal number by
pressing .)

World time Menu 0.7

The World time function provides time
information on major cities worldwide.
You can view the time of the desired country
or city by navigating using  / .
You can select a desired city as a base using
the right soft key [Home].

Voice recorder Menu 0.8

1. Press the left soft key [Options] to display
the option pop up menu before recording.

2. Move to the desired menu item by
scrolling and press .

] Quality: You can select a recording
quality from Super Fine, Fine and
Normal.

] Duration: You can set the recording
duration to MMS msg. size, 30 secs, or 1
min.

] New recording: Select this menu to start
recording to a new file.

] My Files: Opens the Voice recordings
folder in My Files.

] Cancel: Closes the voice recorder and
goes back to the previous screen.

3. Pressing starts recording. When a
recording is started, the recording time
appears on the LCD. To cancel the
recording, press the right soft key
[Cancel].
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4. When you finish the recording, press 
to exit. The recorded file is automatically
saved in the Voice recordings folder in My
files.

5. When no recording is in progress, pressing
starts recording on a new file.

When no recording is in progress, press
the right soft key [Send] to send a
recorded file.

Select one from Message, Email, or
Bluetooth scrolling and press .

6. Press the left soft key to select the various
options after the voice recording.

7. Select the desired menu scrolling and
press .

] Delete: Select this menu to delete a
recorded file.

] New recording: Select this menu to start
a new voice recording.

] Send: To send the recorded file. Select
one from Message, Email and Bluetooth
scrolling and press .

] Sound theme: You can set the recorded
file as the Voice Ringtone, Video
Ringtone, Start up sound or Power off
sound. 

] My Files: Opens the Voice recordings
folder in My Files.

8. Press the right soft key to close the 
sub-menu popup window.
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Phone settings Menu #.1 

Profiles (Menu #.1.1)

You can select ringtone or vibration for an
incoming call and configure the sound and
volume of the ringtone, key tone, and sound
effect, according to a profile. The profiles
provided include [Normal], [Silent], [Vibrate
only], [Outdoor], [Headset], [Customised
1], [Customised 2], and [Customised 3].
Select a profile, and press to activate
the profile. After pressing the left soft key
[Options], select the Edit menu for the
[Normal], [Outdoor], [Headset],
[Customised 1], [Customised 2] and
[Customised 3] profile to change the
configuration. A different list of options is
available for each profile that has been
selected for editing.

Alert by
This option determines the incoming call
notification mode. You can select from
[Ring], [Vibration], [Silent], [Ring &
vibration], [Ring after vibration], [Max Ring &
Vibration].

Voice ringtone
You can select the ringtone for incoming
voice calls.

Video ringtone
You can select the ringtone for incoming
video calls.

Volume
Set the ringtone volume.

Message alert
You can set how often the phone is to inform
you of a received message until it is read.

Message tone
You can select a file from among your own
personal files or from the default files, to be
played by the phone upon receiving a
message.

Key tone
You can set the key tone to be played when
pressing the keys.

Settings [Menu #]
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Key tone volume
You can set the volume of the chosen key
tone, choosing from 7 available levels.

Slide tone
Select the desired tone the phone will emit
when you slide up/down the phone.

Confirmation tone
You can set the confirmation tone to be
played by the phone to confirm actions.

Start up sound
You can set the effect to be played when the
phone is switched on.

Select start up sound
You can select which file will be played when
the phone is switched on.

Power off sound
You can set the effect to be played when the
phone is switched off.

Select power off sound 
You can select which file will be played when
the phone is switched off.

Date & Time (Menu #.1.2)

Although the current time is automatically
configured when the phone is registered to
the network, users can configure the time
and date directly using this menu. The time
configured by the user is valid only while the
phone is turned on.

Time
1. Select the Time item from the Date &

time list, and then press .

2. Move to your desired field, Hour, Minute,
or am/pm field using the scrolling bar.
(When you have selected 12 hour as Time
format)

3. Enter Hour, and Minutes using the
number keys.

4. Select the time format using / .

5. Scroll down to select the hour indicator
format i.e. Off, Cuckoo clock or Chime
bell.
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6. Press the right soft key [Done] to set the
time with the specified value.

Date
1. Select the Date item from the Date &

time list, and then press .

2. Select the date format using / .

3. Enter Day, Month and Year using the
number keys.

4. Press the right soft key [Done] to set the
date with the specified value.

Auto update date/time
When Auto Update is configured to On, the
time and date are automatically updated
according to the current time zone. If
Confirm first is selected, the time and date
update is confirmed before it is updated
automatically.

Daylight saving
Select whether to activate the daylight saving
function or not. You can set the Summer
time difference of selected home city for 1
hour or 2 hours.

Auto key lock (Menu #.1.3)

You can set the desired delay time before
activating the auto key lock. 

After selecting On in Keylock Delay, select
the desired delay time. And press the right
soft key [Done].

Language (Menu #.1.4)

Select the display language. You can select
Automatic language option to change
display language to the USIM card supported
language.

Security (Menu #.1.5)

PIN code request
When this is set to On, you are requested to
enter your PIN each time you switch the
phone on.

75

KU970_Eng(AUS)_0312  07.03.12  11:4 AM  Page 75



Settings

76
Settings

Handset lock
You can lock your phone. The following 4
lock functions are available.

When switching on: Locks the handset
whenever the handset is switched on.

If USIM changed: Locks the handset when
the phone's USIM card has been changed.

Immediate: Locks the handset immediately.

None: Deactivates the lock function.

You are requested to enter the security code
to confirm the selection.

] To unlock the handset, you need to enter
the security code.

Change codes
You can change the PIN, PIN2, the mobile
phone password and the call barring
password.

PIN code

PIN is the abbreviation for Personal
Identification Number, and is used to restrict
use by an unauthorised user. 

PIN code change procedure

1. Select ‘PIN code’ from the ‘Change codes'
list and then press .

2. Enter the current PIN code, and press
.

3. Enter the new PIN code, and press 
.

Note
] Press in the PIN code entry window

to return to the previous step.

] 3 incorrect PIN code entries would
invalidate the PIN code. And you have to
enter the PUK (PIN Unblock Key) code
to configure the PIN code again.

] The maximum number of times you may
enter the PUK code is 10. (Note: If you
enter an incorrect PUK code 10 times,
the USIM card will be blocked and must
be replaced.)

] If the PIN code request cannot be
disabled by operator settings, you will
not be able to choose this menu item.
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4. Enter the new PIN code once again, and
press .

] If the PIN code is different from that of
step 3, the procedure is restarted from
step 3.

5. When the PIN code is changed properly, a
Changed message is displayed. If you
enter an incorrect PIN code in step 2, the
procedure is restarted from step 2, and
the number of attempts you have left to
enter the number decreased by 1.

6. Press in the PIN code entry window
to return to the previous step.

PIN2 code
PIN2 is the abbreviation for Personal
Identification Number 2, and is used to
restrict use by unauthorised users as with the
PIN. The PIN2 code change procedure is the
same as the one for the PIN code. 3
incorrect PIN2 code entries would invalidate
the PIN2 code. In this case, you have to
enter the PUK2 code in order to use the
PIN2 code again. The maximum number of
times you may try to enter the PUK2 code is
10, like PUK1. 10 incorrect PUK2 code
entries would invalidate the PIN2 code.

Security code
The security code is used to change the
mobile phone password. The maximum
number of attempts to enter the security
code is not limited as it is with PIN and PIN2.

Power save (Menu #.1.6)

Decide whether to activate the power save
mode or not. 
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Note
] Three incorrect PIN code entries in the

PIN code entry window would invalidate
the PIN code. In this case, you have to
enter the PUK (PIN Unblock Key) code
to configure the PIN code again. The
maximum number of times you may
enter the PUK code is 10. (Note: If you
enter an incorrect PUK code10 times,
the USIM card will be blocked and must
be replaced.)
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Memory status (Menu #.1.7)

User memory
This function shows the status of the user
memory of the mobile phone. Since this
function scans the overall file system for
statistics, a few seconds are required.

User reserved memory
This function shows the status of the User
reserved memory. The usual contents are
Text messages, Contacts, Calendar, Tasks,
Memo. And it gives a clear illustration of the
actual amount compared with the total
amount for each item.

Mass storage
This function shows the status of Mass
storage.

USIM memory
This function shows the status of the USIM
card user memory.

Format mass storage
You can format the mass storage in phone.

Handset information (Menu #.1.8)

This functions shows the USIM card
telephone number, model name and software
version of the mobile phone.

Reset settings (Menu #.1.9)

Clear memory
Select this to clear the memory. You are
requested to enter the security code.

] Handset contents: Deletes all the
multimedia contents downloaded.

] Handset personal info.: Deletes personal
information such as received messages or
emails.

Default setting
Select this to reset your phone to its default
configuration. You are requested to enter the
security code.
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Display settings Menu #.2

This menu allows you to personalise the
display options of the screens and of the
menus entire graphic interface.

Main display (Menu #.2.1)

You can set the screen theme to be displayed
on the main screen.

Home screen
] Wallpaper: You can select an image to be

displayed on the main screen.

] Display items: You can select which items
to display on the screen: Calendar + Clock,
Calendar, Clock, Dual clock or Do not show.

Outgoing call
You can select the image to be displayed
while dialling a number.

Start up image
You can select the image to be displayed
while the phone is being switched on.

Power off image
You can select the image to be displayed
while the phone is being switched off.

Menu style (Menu #.2.2)

You can select the desired menu style from
Grid style and List style.

Font (Menu #.2.3)

You can set the font style, dialling font size,
and dialling font colour using .

Backlight (Menu #.2.4)

You can set the backlight duration and
brightness on the Home screen.

Welcome message (Menu #.2.5)

After selecting On, you can write a welcome
message.
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Java settings Menu #.3

Activating a profile

1. Move the cursor to the profile you would
like to activate.

2. Press or select Activate from the
Options menu.

Adding a new profile 

1. Select Add new from the Options menu.
The following items need to be configured.

2. Press the right soft key [Done] to save any
configuration changes.

You can edit and delete a profile by selecting
Edit and Delete from the Options menu.

Messaging settings Menu #.4

For detailed information, please refer to page
49.

Call settings Menu #.5

Call durations (Menu #.5.1)

You can view call time by types. Press the left
soft key [Options] to choose either partial
initialisation or entire initialisation. Also press
right soft key [Clear] to initialise a selected
duration type. Initialization will require your
Security code.

The following timers are available:

] Last call: Shows the latest call time in units
of hours/minutes/seconds.

Enter an account name for the profile.Service name 

Choose from the given list of
connection modes. (Default is TCP
with Proxy)

Connection
mode 

Enter the WAP Gateway IP address
provided by the operator. (e.g. 195.
115. 025. 129)

IP address

Port details are provided by the
operator, depending upon the
Connection mode.

Proxy server
port 

Choose from the given list of access
points. (For more details on adding or
editing a new access point, refer to
page 94.)

Access point
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] Received calls: Shows incoming call time.

] Dialled calls: Shows outgoing call time.

] All calls: Shows total call time.

Call barring (Menu #.5.2)

Call barring menus for Voice and Video calls
are provided.

The menu consists of Voice calls, Video calls
and Deactivate all. The Voice calls and Video
calls menus have the following submenus.

The Call barring menu consists of All
outgoing, Outgoing international,
Outgoing international calls except home
country, All incoming and Incoming when
abroad submenus. 

The All outgoing menu bars dialling all
outgoing calls, the Outgoing international
menu bars dialling outgoing international
calls, and the Outgoing international calls
except home country menu bars dialling
outgoing international calls except for the
Home PLMN country. All incoming rejects 
all incoming calls and the Incoming when

abroad menu rejects incoming calls when
roaming.

Video calls & Voice calls
All outgoing

1. When is selected, it receives the
Barring password from user, and activates
the barring service on the network. A
requesting message and animation
appears. When the network answers, the
result of the operation is displayed.

2. When the Options menu is selected, it
activates the Outgoing calls menu. Select
the Options menu from the soft menus on
the lowest menu. Then Deactivate,
Activate, Deactivate all, View status and
Change password menus appear. Select
the Activate menu to receive the Barring
password from the user and activate the
barring service on the network.
The Deactivate menu deactivates the
barring service after the user's Barring
password is entered. The Deactivate all
menu deactivates all barring services
configured in the network after the user's
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Barring password has been entered. The
View status menu enables users to view
the current network configuration.
Selecting View status menu displays the
Requesting message with animation and
the result of the operation when the
network answers. Change password menu
enables users to change the current
barring password.

Outgoing international

1. When is selected, it operates in the
same way as the Outgoing calls menu.

2. When the Options menu is selected, it
activates and operates the International
calls menu. It operates in the same way as
the Outgoing calls menu.

Outgoing international calls except home
country

1. When is selected, it operates in the
same way as the Outgoing calls menu.

2. When the Options menu is selected – It
activates and operates the International
except home country menu. It operates
in the same way as the Outgoing calls
menu.

All incoming

1. When is selected, it operates in the
same way as the Outgoing calls menu.

2. When the Options menu is selected, it
activates and operates the Incoming calls
menu. It operates in the same way as the
Outgoing calls menu.

Incoming when abroad

1. When is selected, it operates in the
same way as the Outgoing calls menu.

2. When the Options menu is selected, it
activates and operates the Incoming calls
when abroad menu. It operates in the
same way as the Outgoing calls menu.
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Fixed dial numbers (Menu #.5.3)

] FDN ON/OFF: Select whether to activate
FDN or not. PIN authentication is required.

] FDN List: Displays the current FDN list.
You can edit, add, or delete fixed dial
numbers. PIN2 authentication is required
to edit the list. And the configuration
information is saved on the USIM. The
information saved on the USIM is used
when FDN restricts outgoing calls.

Data volume (Menu #.5.4)

Allows you to check the sent, received and all
data volume transferred. (Data volume
transferred through TE connection is
excluded from counting.) 

Press the left soft key [Options] to choose
for partial initialization or entire initialization.
You can also use the right soft key [Clear]
for the initialization of the selected volume
type. Initialization will require your Security
code.

Call costs (Menu #.5.5)

1. This function displays the call costs of the
Last call and All calls.

2. To initialise, press the right soft key
[Clear] and enter the PIN2 code.

3. You can select either Units or Currency in
Set call cost. According to your setting,
the call cost is displayed during a call (If
USIM and Network support Advice Of
Charge(AOC)).

4. In the Set limit configuration, select On
to configure the cost limit. When a cost
limit is configured, and the call costs reach
the limit, making a call will not be allowed.
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Diverts (Menu #.5.6)

Call divert menus for voice and video calls
are provided.

The menu consists of Voice calls, Video calls
and Deactivate all.

Voice calls
All voice calls

When busy

No answer

Not reachable

1. When the Deactivate menu is selected 
Deletes Call Divert Number registered to
the network. While waiting for the result
from the network, Requesting message
and animation appears. When the network
answers, the result of the operation is
displayed.

2. When To a number is selected
A dialogue window appears allowing you
to enter a phone number to divert to.
Input a phone number to divert calls to,
and press . While waiting the result

from the network, Requesting message
and animation appears. When the network
answers, the result of the operation is
displayed.

3. When Recent divert number list is selected
Divert registration is performed with the
selected number. Select the number, and
press . While waiting for the result
from the network, a Requesting message
and animation appears. When the network
answers, the result of the operation is
displayed.

4. Options menu
After activating All voice calls menu,
selecting the Options menu at the bottom
of the menus displays the Deactivate,
Activate, Deactivate all, View status and
clear list menus.
Activate: Move to Settings menu to
activate call divert.
The View status menu shows the settings
on the network. If you select this menu,
Requesting. message and animation
appear. Then the network settings are
displayed when the information is received
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from the network. Selecting Status in the
right soft menu gives the same result. If
you select the Deactivate menu, the call
divert numbers registered in the network
are deleted after user confirmation.
Selecting the Cancel all menu will display
the operation result after showing the
Requesting message and animation.
Clear list menu will delete all divert
number list.

Video calls
All video calls

1. When the Deactivate menu is selected 
Deletes Call Divert Number registered to
the network. While waiting for the result
from the network, Requesting message
and animation appears. When the network
answers, the result of the operation is
displayed.

2. When To a number is selected
A dialogue window appears allowing you
to enter a phone number to divert to.
Input a phone number to divert calls to,
and press . While awaiting the result

from the network, Requesting message
and animation appears. When the network
answers, the result of the operation is
displayed.

3. When Recent divert number list is selected
Divert registration is performed with the
selected number. Select the number, and
press . While waiting for the result
from the network, a Requesting message
and animation appears. When the network
answers, the result of the operation is
displayed.

4. Options menu
After activating the All video calls menu,
selecting the Options menu at the bottom
of the menus displays the Deactivate,
Activate, Deactivate all, View status and
clear list menus.
Activate: Move to Settings menu
(above1~4) to activate call divert. The
View status menu shows the settings on
the network. If you select this menu,
Requesting. Message and animation
appear. Then the network settings are
displayed when the information is received
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from the network. Selecting Status in the
right soft menu gives the same result.
If you select the Deactivate menu, the call
divert numbers registered in the network
are deleted after user confirmation.
Selecting the Cancel all menu will display
the operation result after showing the
Requesting message and animation. Clear
list menu will delete all divert number list.

When busy

1. When the Deactivate menu is selected
It operates the same as All voice calls
menu.

2. When To a number is selected
It operates the same as All voice calls
menu.

3. When Recent divert number list is
selected
It operates the same as All voice calls
menu.

4. When Options menu is selected
It activates and operates If busy menu. It
operates the same as All voice calls menu.

No answer

1. When the Deactivate menu is selected
It operates the same as All voice calls
menu.

2. When To a number is selected
It operates the same as All voice calls menu.

3. When Recent divert number list is
selected 
It operates the same as All voice calls
menu.

4. When Options menu is selected
Activates and operates No answer menu. It
operates the same as All voice calls menu
except that users can configure delay time
in the Set waiting time menu in the menu
list.

Not reachable

1. When Deactivate menu is selected
It operates the same as All voice calls
menu.

2. When To a number is selected
It operates the same as All voice calls
menu.
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3. When Recent divert number list is
selected
It operates the same as All voice calls
menu.

4. When Options menu is selected
Activates and operates If out of reach menu. 
It operates the same as All voice calls menu.

Call waiting (Menu #.5.7)

] Activate: Activates waiting service.
Selecting this item, displays requesting
message and animation. When the network
answers, the result of the operation is
displayed.

] Deactivate: Deactivates Call waiting
service. Selecting this item displays
requesting message and animation. When
the network answers, the result of the
operation is displayed.

] View status: Displays activated Call waiting
service group item of the network.
Selecting this item displays requesting
message and animation. When the network
answers, the result of the operation is
displayed.

Voicemail (Menu #.5.8)

You can add or modify voice mail centre.

Video call (Menu #.5.9)

You can set the screen display when making
/receiving a video call.

] Show private image: Determine whether
to show the private image or not.

] Select still image: Select the still image to
be displayed.

] Mirror: Select to activate the mirror effect
or not.

- On: Displays the image flipped side to
side.

- Off: Displays the image as it is.

] My image size: Select my image size to be
displayed.

] My image position: Select the position
where your image will be displayed.
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Common settings (Menu #.5.0)

Call reject
You can set whether to reject incoming calls.

1. Select On in Reject menu to activate call
reject. The Reject list menu appears.

2. Set the desired call reject option in the
Reject list menu.

] All calls: Rejects all calls.

] Contacts: Rejects the calls from the
number stored in Contacts.

] Groups: You can specify call rejects by
group units stored in Contacts.

] Unregistered: Rejects calls from the
number not stored in Contacts.

] No caller ID: Reject calls which do not
have CLI information.

Send my number
] Set by network: Configures with the

default settings determined by the service
provider.

] On: Configures to send my phone number
when making an outgoing call.

] Off: Configures not to send my phone
number when making an outgoing call.

Auto redial
Allows you to set the auto redial function
when a call attempt has failed.

Answer mode
Allows you to set the answering method. You
can choose between Press send key , Slide
up and Press any key.

Minute minder
Determines whether to sound a 1 minute
tone every 1 minute when you are on the
phone.
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BT answer mode
] Hands-free: You can answer a call using

the Bluetooth headset, when the Bluetooth
is connected.

] Handset: If you press on the handset
to answer a call, you can talk on the
handset. If you press the Bluetooth
headset key to answer a call, you can talk
using the Bluetooth headset.

This is the initial answer mode selection. And
while talking, you can switch from handset to
headset or from headset to handset.

Contact settings Menu #.6

For detailed information, please refer to page
57. (Menu 7.7)

Connectivity Menu #.7

Bluetooth (Menu #.7.1)

Bluetooth QD ID B012430

Bluetooth connection
Your phone has built-in Bluetooth wireless
technology which makes it possible for you
to connect your phone wirelessly to other
Bluetooth devices such as a handsfree, PC,
PDA or other phones.

You can, for example, have a conversation via
a cordless Bluetooth handsfree or browse the
Internet, wirelessly connected via a mobile
phone. You can also exchange, for example,
business cards, calendar items and pictures.

89

Note
] We recommend that your phone and

the Bluetooth device you are
communicating with be within a range of
10 meters. The connection may be
improved if there are no solid objects
between your phone and the other
Bluetooth device.
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1. Getting started

• Menu > #. Settings > 7. Connectivity > 
1. Bluetooth > 1. Paired devices

To use the Bluetooth function, you must first
set Bluetooth to On.

2. Configuring Bluetooth settings

• Menu > #. Settings > 7. Connectivity > 
1. Bluetooth > 2. Settings

- Bluetooth usage: To use the Bluetooth
function, set it to [On]. Otherwise, set it to
[Off].

- My handset’s visibility: Set [My handset’s
visibility] to [Show to all] so that other
devices can detect your phone when they
are searching for a Bluetooth device. If you
select [Hidden], other devices will not be
able to detect your phone when they are
searching for a Bluetooth device.

- My handset’s name: You can name or
rename your phone as it will appear on
other devices. Your phone's name will be

shown on other devices only when [My
handset’s visibility] is set to [Show to all].

3. Paired device

Pairing Devices(Pairing with a device)

If a paired Bluetooth device already exists.

• Menu > #. Settings > 7. Connectivity >
1. Bluetooth > 1. Paired devices >
Options > Add new

If there is no paired Bluetooth device.

• Menu > #. Settings > 7. Connectivity > 
1. Bluetooth > 1. Paired devices > Add

Options

] Add new: Using this menu, you can pair a
new Bluetooth device with your phone.

Note
] When user uses Bluetooth Device in the

handset, the security of the handset is at
risk.
Therefore, we recommend that Bluetooth
visibility be set to Hidden after
configuration or device pairing.
For incoming files via Bluetooth
regardless of paired devices, you can
choose to accept or reject the
connection, after checking the sender
details. 
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] Assign short name: Using this menu, you
can rename a paired phone as required.

] Connecting/Disconnecting the device

1. If you want to open the connection to
the selected device, select the Connect.

2. If you want to close the connection to
the selected device, select the
Disconnect.

] Delete: Using this menu, you can delete
the paired Bluetooth device.

] Delete all: Using this menu, you can delete
all of the paired Bluetooth devices.

<Pairing devices>

1. To search for a Bluetooth device to pair,
press Add or Add new.

2. Screen shows Searching for devices.
Bluetooth devices within a range of 10m
will be found.

3. If Bluetooth devices are found, these
devices are listed on the screen. If no
Bluetooth device is found, you will be
asked if you want to search again.

4. Pairing procedure

- Press . A window will appear on
the screen asking you to enter your
password.

- After creating a password (of 1 to 16
digits), the user of the other device
must enter the password for pairing.
The user of the other device must know
the password in advance for
authentication.

<Deleting devices>

1. Select a device to delete from the Paired
devices screen.

2. You can delete a device by pressing the
Delete key or by selecting Options >
Delete. To delete all paired devices, select
Options > Delete All.

<Transmitting data using Bluetooth>

1. To transmit data from your phone to
another Bluetooth device, first select the
application where the target data is saved.
For example, to send data in the My Files
to another device, select

91
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Menu > . My Files > 1. Pictures /
2. Sounds / 3. Videos/ 5. Bluetooth data
/ 6. Other files > Select data to transmit >
Send > 3. Bluetooth

2. Transmitting data

1) Last device found is displayed. If the
desired device does not exist in the
list, select [More devices].

2) Select the device to which you want
to transmit data from the devices on
the screen and press .

3) If the other party selects [Yes] for
[Connection request], the data is
transmitted.

<Receiving data using Bluetooth>

Menu > #. Settings > 7. Connectivity > 
1. Bluetooth > 1. Paired devices

If another party attempts to transmit data,
the [Connection request] question will
appear on the screen. If you select [Yes], the
data will be transmitted to your phone.
During data transmission, the Bluetooth icon
flashes.

<Bluetooth data storage folder>

You can check the received data by selecting
Menu > . My Files > 5. Bluetooth data.

4. Device

<Connecting a headset>

Menu > #. Settings > 7. Connectivity >
1.  Bluetooth > 1. Paired devices

1. Connect the headset according to the
procedures described in the Pairing
Devices section.

2. To use the headset, select the headset
from the registered devices, press the
Option key and then select 3.Connect.

3. To check that the selected headset has
been connected successfully, press the
Option key. If it is properly connected,
3.Disconnect will appear. If it is not
connected, 3.Connect will appear.

<Connecting a handsfree kit>

1. Menu > #. Settings > 7. Connectivity > 
1. Bluetooth > 1. Paired devices

2. Connect the handsfree kit according to
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the procedures described in the Pairing
Devices section.

3. To use the handsfree kit, select the
handsfree kit from the registered devices,
press the Option key and then select
3.Connect.

4. To check that the selected handsfree kit
has been connected successfully, press the
Option key. If it is properly connected,
3.Disconnect will appear. If it is not
connected, 3.Connect will appear.

Synchronisation (Menu #.7.2)

This menu allows you to synchronise your
schedule, contacts, memos with calendar and
phonebook applications on a compatible
computer or on the internet. 
The synchronisation application uses SyncML
technology. 

] Connect: You can try to connect to server
for synchronisation. For more details,
contact your service provider for more
information.

] Logs: After synchronisation is complete,
you can view a log file showing the status
and how many entries have been added,
updated, deleted or discarded in the phone
or on the server.

] Server sync. centre: You can activate the
server. You can also add new server or edit
it.

Network (Menu #.7.3)

Network selection
Select between Automatic and Manual.

] Automatic: Automatically searches for the
network and registers the handset to the
network. This is recommended for best
service and quality.

] Manual: All the currently 2G(GSM) and
3G(UMTS) available networks are shown
and you can select one of them for
registration. If the registration of the
network has failed, all the currently
available networks are listed again and you
can select any other one for registration.

93
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Network mode
You can set a type of network to search for
when networks are searched in the network
selection.

] Automatic: Searches all the networks
connectable.

] UMTS: Searches only networks supporting
3G.

] GSM 900/1800: Searches only networks
supporting GSM 900/1800 band.

] GSM 1900: Searches only networks
supporting GSM 1900 band.

Preferred lists

If the network is searching automatically, you
can add a preferable network to be
connected to. And the following options are
available.

] Add new: You can add a new network using
the followings.

- Search: You can select one from the
network list stored in the phone.

- Enter new network: You can enter the
country code (MCC) and the network
code (MNC) to add. After setting, press
Done key.

] Edit: You can modify the information of
the selected network.

] Delete: Deletes the selected network.

] Move up: Moves the selected network
upward.

] Move down: Moves the selected network
downward.

Access points (Menu #.7.4)

This menu shows the access point list. You
can create new profiles, delete or edit them
by using the Option Menu. However, you
cannot delete or edit default configurations
depending on country variant.
You can edit the following configuration
items by selecting the right soft key.
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] Press Done key to save any configuration
changes.

Browser settings (Menu #.7.5)

Profiles
Select the appropriate profile by pressing 

. This will activate the profile to initiate
browser launch.

Security
If user presses Certificates, certification
information is shown.
User can clear secure session information by
pressing Session clear.

Certificates
If stored, a list of root/ca certificates required
for WTLS/TLS can be found here.
Certificates can be viewed from the list.

Session clear
Secure (WTLS/ TLS) session data can be
cleared using this option. Session data
should be cleared to establish a new secure
session.

Character encoding

Sets the browser default character set to one
of the following.

] Automatic, English(ASCII), English(ISO),
English(LATIN), Unicode(UCS2 BE),
Unicode(UCS2 LE), Unicode(UCS2 Auto),
Unicode(UTF-16 BE), Unicode(UTF-16 LE),
Unicode(UTF-16 Auto), Unicode(UTF-8).

Scrolling control
Allows you to set the scroll speed by
selecting the number of lines to scroll. 
Select from Small(1 line), Medium(2 lines),
Large(3 lines).
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Access Point profile name.Connection title

Choose the bearer from the list.
(Default is UMTS.)

Bearer

Choose the authentication from the
list. (Default is No auth)

Authentication

Information provided by service
provider.

User name

Information provided by service
provider.

Password

APN name to access network.
Information provided by service
provider.

APN

KU970_Eng(AUS)_0312  07.03.12  11:4 AM  Page 95



Settings

96
Settings

Show Image 
Allows you to enable or disable image display
during browsing.

Cache
Enabling Cache allows you to store accessed
pages to your phone. Once a page has been
stored in cache it will greatly enhance the
page loading speed on subsequent browsing
of the same page.

Cookies 
Enabling Cookies allows you to store cookies
sent from the server. Disabling this function
will prevent cookies from being stored on
your phone.

JavaScript
Select On/Off.

Reset settings
Select this to reset your phone to its default
configuration.

Streaming (Menu #.7.6)

If you want to set different network setting to
play streaming content, you can set different
network settings.

Dial-up network (Menu #.7.7)

You can use your phone with a variety of PC
connectivity and data communications
applications. Select USB and Bluetooth you
want to use for the data connection.

Note
] Enabling this function will delay

displaying of images until transmission is
completed. Disabling this function will
prevent the browser from downloading
images from the server, thus allowing
faster transmission.
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There are various accessories for your mobile phone. You can select these options according to
your personal communication requirements.

Travel Adapter 
This charger allows
you to charge the
battery while away
from home or your
office.

Standard Battery 

Data cable/CD 
You can connect your
phone to PC to
exchange the data
between them. 

Hands free ear-microphone and music
player controller combo 
Stereo headset

Controller: Answer &
End key, music player
control, volume
control, Hold button and microphone.

After connecting the headset and the
controller, plug the end of controller into the
headset jack on the right side of the phone.

Note
] Always use genuine LG accessories.

] Failure to do so may invalidate your
warranty.

] Accessories may vary in different regions:
please check with our regional service
company or agent for further
information.
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Technical data

General 
Product name: KU970 

System: GSM900/DCS1800/PCS 1900,
WCDMA 2100

Net weight: 67.5g(Without battery)

Ambient Temperatures
Max: +55°C (Normal) / 45°C (Charging)

Min: -10°C
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Index

A
Access codes 21
Access points 94
Add memo 70
Add new 56
Alarms 67
Answer mode 88

B
Backlight 79
Barring password 24
Battery 17, 97
Battery information and care 11
Bluetooth 89
Bluetooth data 65
Browser settings 59, 95

C
Calculator 70
Calendar 67

Call barring 80
Camera 34
Charging the battery 19
Converter 71

D
Data cable 97
Dialled calls 41
Display information 22
Display settings 79
Diverts 84

E
E-Mail 44, 47, 52
Entering text 27

H
Handset Information 78
Handset lock 76
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Inbox 45

J
JavaScript 60, 96
Java settings 61, 80

K
Key tone 73

L
Language 75

M
Memo 67
Memory status 78
Message alert 73
Message tone 73
Missed calls 41
MMS 50

N
Network 93
Network selection 93

O
Own number 57

P
PIN code 21
PIN code request 75
PIN2 code 20, 77
Playlists 33
Profiles 59, 73
PUK code 22
PUK2 code 22
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R
Received calls 41

S
SAR 7
Screen structure 23
Security 59, 75, 95
Security code 22, 77
Signal Strength 27
Speed dials   56
Stereo headset 97

T
Tasks 67
Templates 49

U
USIM memory 78
USIM Tool Kit 32

V
Videos 62
Voice calls 84
Voice mail 87
Voice recorder 71
Volume 73

W
World time 71
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